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评审专家最关心什么？
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面对海量文献，如何充分挖掘文献价值，

以使其更好地服务于科学研究？
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Wisdom

Knowledge

Information

Data

[1] Ackhoff, R. (1989). From Data to Wisdom. Journal of Applied Systems Analysis. 16. 3-9. 
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罗素 ·艾克夫

From Data to Wisdom



Web of Science
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Web of Science -全球最大规模的出版商中立引文索引和研究情报平台

19,000,000+
附加基金数据的记录

134,000+
图书

14,000,000+
数据集和数据研究

21,000+
核心合集期刊

34,000+
全平台期刊

107,000,000+
专利

数据更新时间：2022年7月

300,000+
会议

193,000,000+
文献记录

1864
最早回溯年

2,248,000,000+
参考文献
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Science Citation Index Expanded™ (SCIE，科学引文索引)

数学 计算机科学 园艺学 地质学

物理 自动控制 能源与燃料 工程

化学 植物学 医学 材料科学

生物 昆虫学、动物学 心理学 教育

生态学 结晶学 天文学和天体物理学 海洋学

生理学 环境科学 食品科学 光学

农业、农学 行为科学 声学 ……

178
Web of Science 类别

9,500+
期刊

60,000,000+
文献记录

1900
最早回溯年

数据更新时间：2022年7月
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Social Sciences Citation Index™ (SSCI，社会科学引文索引)

人类学 经济学 老年医学 法律

区域研究 教育和教育研究 卫生政策和服务 语言学

商业 环境研究 历史 管理学

文化研究 人类工程学 休闲、运动和旅游 护理

沟通 伦理学 工业关系与劳工问题 心理学

犯罪学和刑罚学 家庭研究 图书馆学与情报学 政治学

人口统计学 地理 国际关系 ……

58
Web of Science 类别

3,500+
期刊

10,000,000+
文献记录

1900
最早回溯年

数据更新时间：2022年7月
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Arts & Humanities Citation Index®(AHCI，艺术人文引文索引)

考古学 文化研究 人类学 音乐

建筑学 舞蹈 语言和语言学 哲学

艺术 电影、广播、电视 文学、文学评论 诗歌

亚洲研究 民俗 文学理论和批评 宗教

古典希腊和罗马文学 历史 中世纪和文艺复兴研究 ……

28
Web of Science 类别

1,800+
期刊

5,000,000+
文献记录

1975
最早回溯年

数据更新时间：2022年7月



• Dr. Garfield 1955年在 Science 发表论文提出将

引文索引作为一种新的文献检索与分类工具：将

一篇文献作为检索字段从而跟踪一个Idea的发展

过程及学科之间的交叉渗透的关系。
Dr. Eugene Garfield

（1925. 9.16–2017.2.26）

美国情报学家和科学计量学家

美国科学信息研究所创始人

Unique 
Data 

独特
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关键词的不断演变，造成漏检，

错过高影响力的重要文献

从一篇高质量的文献出发，沿着

科学研究的发展道路前行

相关记录

2004

1999

1976

1994

引用

▪ 越查越广

2010

1989

施引文献

1984

1980

▪ 越查越新

1979

参考文献

1970
1977

1976

1973

▪ 越查越深

引文索引 OR 关键词检索
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划重点：相关记录
论文甲 论文乙

A B C D E F

Synthesis of Amino Acids

Synthesis and/or collection of 
Synthesis and/or collection of 
amino acids is critical for cell 
survival. They not only serve as 
the building blocks for proteins 
but also as starting points for the 
synthesis of many important 
cellular molecules including 
vitamins and nucleotides.
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Synthesis of Amino Acids

Synthesis and/or collection of 
Synthesis and/or collection of 
amino acids is critical for cell 
survival. They not only serve as 
the building blocks for proteins 
but also as starting points for the 
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cellular molecules including 
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Synthesis of Amino Acids

Synthesis and/or collection of 
Synthesis and/or collection of 
amino acids is critical for cell 
survival. They not only serve as 
the building blocks for proteins 
but also as starting points for the 
synthesis of many important 
cellular molecules including 
vitamins and nucleotides.
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如何充分发挥Web of Science平台的价值？
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研究前沿报告

2021年12月8日，科睿唯安与中国科学院向

全球联合发布了《2021研究前沿》报告，这是双

方连续第八年携手发布《研究前沿》系列报告。

《2021研究前沿》报告依托于中国科学院杰

出 的 文 献 分 析 实 力 ， 根 据 科 睿 唯 安 Web of

Science和Essential Science Indicators （基

础科学指标，简称ESI）的高质量数据，遴选出

了自然科学和社会科学的 11 个大学科领域排名

最前的 110个热点前沿和 61个新兴前沿。
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2021年研究前沿报告发布现场（扫码下载研究前沿报告）



案例：探索进行自然水体污染防治相关研究的可行性
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什么是自然水体污染防治？

自然水体污染

防治

• 工业治污

• 城镇生活治污

• 农业农村治污

• 船舶港口治污等
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这个领域值得研究吗？
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确定检索式初步搜集文献
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如何在检索中尽可能保证查准查全？



确定关键词

专业词汇

词典/手

册

术语名词

网站



3. 已有的文献信息
多篇文献综合！

…………
1 制备 — synthesis

2 制备 — preparation

3 生长 — growth

…………

确定关键词
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布尔逻辑运算符

检索包含所有关键字的数据。

标题： “stem cell*” AND lymphoma

检索含有“stem cell”或者”stem cells”同时含有及词语 “lymphoma”。 等效于
检索“stem cell*” lymphoma

检索的数据中至少含有一个所给关键字。用语检索同义词或者词的不同表达
方式

标题: aspartame OR saccharine OR sweetener* 

检索至少含有一个关键字的数据。

排除含有某一特定关键字的数据

标题: aids NOT hearing

检索含有“aids”的数据，排除含有“hearing”的文献。

文献检索

查准查全
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通配符

符号 意义

*

零个或多个字符

gene*

gene, genetics, generation

$

零或一个字符

colo$r

color, colour

?

只代表一个字符

en?oblast

entoblast, endoblast

文献检索

查准查全
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位置限定运算符

SAME

在“地址”检索中，使用 SAME 将检索限制为出现在“全
记录”同一地址中的检索词。

范例:  AD=((Tsinghua univ) SAME (key lab*)) 查找在记
录“地址”字段中存在Tsinghua univ和key lab*的记录。

NEAR/x

使用 NEAR/x 可查找由该运算符连接的检索词之间相隔
指定数量的单词的记录。

用数字取代 x 可指定将检索词分开的最大单词数。

范例：salmon NEAR virus
salmon NEAR/15 virus

文献检索

查准查全
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检索运算符优先顺序

1. 如果在检索式中使用不同的运算符，会根据下面的优先顺序处理检索式：

2. 使用括号可以改写运算符优先级。

文献检索

查准查全
NEAR/x

SAME

NOT

AND

OR
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隐含的 AND 运算符

文献检索

查准查全

在大多数字段输入两个或两个以上相邻的检索词时，Web of Science 检索会

使用隐含的 AND 运算符。例如，在所有字段检索中输入 rainbow trout fish 

farm 与输入 rainbow AND trout AND fish AND farm 等效；这两条检索式将

返回相同数量的结果。

中文和韩文检索与此不同，它们不会使用隐含 AND 逻辑。

以下检索式效果不相同：

•标题: (海洋 地震) 将返回标题中带有相邻的“海洋”和“地震”的记录。

•标题: (海洋 AND 地震) 则会返回标题中同时带有“海洋”和“地震”的记

录。但这两个词不一定相邻。
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使用引号

文献检索

查准查全

使用引号可以查找精确匹配的短语，还可以关闭词形还原和产品的

内部同义字查找功能。例如：

•"soil drainage" 查找 soil drainage，但不查找 drainage of soil。

•"mouse" 查找 mouse，但不查找 mice。

•"color" 查找 color，但不查找 colour。
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更多检索规则，请访问：



一体化总览研究成果——创建引文报告

检索结果：8419

创建引文报告
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一体化总览研究成果——创建引文报告

篇均被引频次：24.66

被引频次总计：207,595
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一体化总览研究成果——创建引文报告

按年份的被引频次和出版物分布
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全方位审视当前研究成果——分析检索结果
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分析检索结果



全方位审视当前研究成果——分析检索结果——所属机构

中国科学院

印度理工学院
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初步结论：

自然水体污染防治相关研究

靠谱！
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那么问题来了

自然水体污染防治相关领域

已经做了哪些研究，进展如何？
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看综述（REVIEW）！
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探索领域研究进展——查看综述（REVIEW）

综述论文
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探索领域研究进展——查看综述（REVIEW）

检索结果：809
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初步了解研究进展后，

如何选择细分/交叉方向

进行研究？
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探索感兴趣的研究方向——查看Web of Science类别

Web of Science类别

43

选择“ENGINEERING ENVIRONMENTAL”



探索感兴趣的研究方向——查看Web of Science类别

检索结果：1653
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1653篇？？？！！！！

我应该先读哪些文献？
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发现最有价值文献——被引频次降序

被引频次：最高优先
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发现最有价值文献——进入TOP1论文全记录页面

48

阿德莱德大学



发现最有价值文献——通过施引文献追踪后续研究

被引频次：3513
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发现最有价值文献——通过施引文献追踪后续研究

50

日本国立材料科学研究所科研团队研究成果

被引频次：最高优先

华南农业大学生物质工程研究院院长谢君教授团队成果



发现最有价值文献——通过参考文献追溯研究基础

引用的参考文献：240
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发现最有价值文献——通过参考文献追溯研究基础
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“光催化之父”，中国工程院外籍院士 、东京理科大学
第9任校长，藤岛昭（Fujishima Akira）教授的成果

被引频次：最高优先



发现最有价值文献——通过相关记录拓展文献视野

查看相关记录
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发现最有价值文献——通过相关记录拓展文献视野
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相关性



高影响力的经典文献有了

想看最新前沿研究文献怎么办？
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发现最新研究成果——日期降序

日期降序
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发现近期热门成果——使用次数排序

使用次数：最多优先
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划重点：使用次数

使用次数反映了某篇论文满足用户信息需要的次数，具体表现为：

1.用户点击了指向出版商处全文的链接（通过直接链接或 Open URL）。

2.对论文进行了保存以便在题录管理工具中使用（通过直接导出或保存为可以之后

重新导入的其他格式）。

使用次数是所有Web of Science用户执行的活动的记录，而不仅仅是您所在机构

的用户执行的活动。使用次数每天更新。
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更多精炼条件

精炼条件 精炼条件

高被引论文 开放获取

热点论文 在线发表

出版年 会议名称

Web of Science类别 国家/地区

文献类型 编者

所属机构 团体作者

基金资助机构 语种

作者 研究方向

出版物标题 Web of Science索引

59



基金资助项目分析——查看基金资助机构

基金资助机构-NATIONAL NATURAL 
SCIENCE FOUNDATION OF CHINA
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探索国内国际合作——查看国家/地区

国家/地区-PEOPLES R CHINA 
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Web of Science每天都在更新

如何快速追踪最新研究成果？
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文献跟踪——创建跟踪服务

创建跟踪服务
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文献跟踪——创建跟踪服务
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文献跟踪——创建引文跟踪

创建引文跟踪
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文献跟踪——创建引文跟踪
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找对了文献，

是不是要开始研读文献全文了？
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了解更多文献信息——论文全记录
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了解更多文献信息——论文全记录
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划重点：EndNote Click（一键获取全文 ）
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划重点：EndNote Click（一键获取全文 ）
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划重点：EndNote Click（一键获取全文 ）
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划重点：EndNote Click（一键获取全文 ）



EndNote Click
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划重点：EndNote Click（一键获取全文 ）



划重点：更多全文下载方式

WoS全文链接按钮

馆际互借

图书馆文献传递

免费全文网站

提供免费全文的期刊

作者E-mail联系或作者主页

开放获取（OA）
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文献太多，有点抓狂？

78
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文献管理神器

EndNote 了解一下！

79
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EndNoteTM20 的工作流

80

Author

Title

Year

Journal

…

Filte
rs

EndNote Library

O
u

tp
u

t 
S
tyle

s

投
稿

数据库
文献记录

文献管理

文献分析

识别数
据库导
出的文
献字段

组合成
期刊要
求的文
献格式



1. 文献导入
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EndNoteTM 20的文献导入
收集文献信息的多种方式

 PDF文件如何导入？

PDF文件的快速导入

以文件夹形式导入（手动导入+自动导入）

 一键下载PDF并导入——EndNote Click（Kopernio）

 已经整理好的文献资料，可以导入吗？

其他管理软件的文献资料转换导入（RIS格式文件导入）

 使用数据库检索论文的时候，批量文献信息如何导入？

直接导入——Web of Science平台

转换导入——知网及更多平台（ Import Files）

 EndNote在线检索并导入

 手动新增文献记录
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◼ PDF文件如何导入？
PDF文件的快速导入

• 选中本地PDF文件

• 拖拽至EndNote 20的相应位置

PDF常用导入途径：

EndNote 20菜单栏File → Import→ File
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选择导入到EndNote

84

EndNote Desktop

◼ 使用数据库检索论文的时候，批量文献信息如何导入？
直接导入——Web of Science平台

双击后自动导入
EndNote 20



◼ EndNoteTM20的在线检索并导入

 更多在线检索数据库选择

方法1：点击more…

方法2：Tools → Connection Files

1）选中心仪的文献

2）点击右上“+”快捷键

快速添加至本地文献组（Groups）

设定
检索条件

选择
在线检索源

Online Search在线检索 EndNote提供了6000多个在线资源数据库！
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2. 文献管理

86



EndNoteTM 20的文献管理
整理文献信息的功能介绍

 文献分组

Create Groups

Create Smart Groups

Create from Groups

 文献去重

 查找全文
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 Create Groups

 Create Smart Groups

 Create from Groups

✓ 把目标文献添加到组（直接拖动或右键添加）

✓ 所有组按照字母顺序进行排序

✓ 按照设置条件自动挑选符合条件的记录

✓ 在有新记录收入时自动将符合条件的记录放入Smart Group

✓ 将已经设置好的组用AND, OR 和NOT进行组与组之间的匹配

如寻找组与组之间的交集或并集等

增加新文献时

组内自动更新

Group Set

Group

Group

⚫ 支持多达5000个Group Sets 

⚫ 支持多达5000个Groups 

◼ 文献的分组

选择“Groups” tab 点击“Create Group”
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◼ 文献的去重
Find Duplicates

 “重复文件”定义的设置途径

Edit → Preferences

✓ 支持DOI号和PMCID号
精准定位重复文献记录
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选择要查找全文的文献 选择“References” 点击“Find Full Text…”

Find Full Text帮助
查找全文

◼ 轻松获取文献全文

已找到全文



3. 文献分析
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EndNoteTM 20的文献分析
了解已有文献的影响力和发展

 与Web of Science的无缝连接

Web of Science 全记录页面

Web of Science 相关记录结果

一键式引文报告生成

 基于个人图书馆的文献统计分析
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✓ 实时、持续更新

提供不受学科界限限制全面观察科技发展的能力

引文网络

您可能也想要…BETA

✓ 基于算法助您发现更多关联资源

详尽且丰富的文摘信息

◼ 与Web of Science的无缝连接：全记录页面
Web of Science article record

References>>Web of Science>>
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Web of Science related records

✓ 借助引文索引的力量，

寻找更多交叉学科的创新点和研究思路

相关记录检索结果

◼ 与Web of Science的无缝连接：相关记录

References>>Web of Science>>
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引文报告

Create Citation Report

◼ 与Web of Science的无缝连接：创建引文报告

References>>Web of Science>>

✓ 支持分析整组文献的引文影响力

✓ 借助Web of Science平台对最新研究进展多视角分析
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◼ 基于个人图书馆的文献统计分析
Subject Bibliography

✓ 对多渠道整理的资料信

息进行整合统计分析

✓ 支持多字段合并统计

✓ 基于关键要点，快速挑

选并分类已有信息

Tools-Subject Bibliography-Subject Fields
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分子动力学模拟

矩阵乘积态，MPS

随机森林

相变

示例：对已整理的文献进行关键词（keywords）统计分析

示例：基于感兴趣的关键词挑选文献，并自动呈现分类结果

◼ 基于个人图书馆的文献统计分析
Subject Bibliography

Tools-Subject Bibliography-Subject Fields

查看相关文献数量
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4. 参考文献编辑与投稿
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EndNoteTM 20的参考文献编排

 添加参考文献

 参考文献的调整

 参考文献的分类显示

 参考文献的一键格式修改

 获得更多参考文献格式模板

 创建自定义的参考文献格式（简版）

 投稿期刊推荐
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Cite While You Write：实现Word与EndNoteTM20之间的对接

100

在EndNote网络版中下载插件，可在使用WORD撰写论文时，自动插入参考文献并设置引文
和书目的格式。

边写作边引用

❖ 安装好EndNote单机版后，可自动实现Word与EndNote之间的对接。



Cite While You Write

Cite While You Write：实现Word与EndNoteTM20之间的对接

❖ 安装好EndNote单机版后，可自动实现Word与EndNote之间的对接。
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◼ 添加参考文献
Insert Citation

❶选择合适的参考文献格式

❷在文中指定添加参考文献的位置

❸

❹输入检索词汇

❻选中待添加的参考文献

❺

❼
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◼ 参考文献格式一键切换
Style下拉菜单

Style: ACS Style: Nano Letters

一键式调整整篇文章的
文中及文后参考文献格式
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5. 文献备份与共享
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EndNoteTM 20的备份与共享

• 移动便携——压缩个人图书馆

• 同步备份

• Email一键发送

• 共享你的分组

• 共享你的图书馆

❖ 备份与同步

❖ 资源共享
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◼ 移动便携——压缩个人图书馆
Compressed Library便于携带与共享

File → Compressed Library(.enlx)…

• 带附件压缩

• 仅指定压缩某个组

• 不带附件

• 压缩完整图书馆

• 压缩选中的参考文献

File → Open Library…◼ 打开已压缩图书馆
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◼ 共享你的分组
Share Group/ Share this Group

通过输入email地址
邀请共享文献分组

在共享时可限定访问权
限为“只读”或“读写”

Groups > Share groups …

快捷分享分组
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EndNoteTM20 的工作流
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关注官方平台，第一时间获取最新资讯！

科睿唯安
微信公众号

更多课程

更多材料

更多报告
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